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Chapter 1.  Overview of the MPLAB® Xpress Ecosystem

1.1 INTRODUCTION

MPLAB® Xpress is an ecosystems is comprised of:

• MPLAB Xpress IDE

• MPLAB Code Configurator

• MPLAB Xpress Evaluation Boards

• Other Compatible Hardware

1.2 MPLAB XPRESS IDE

MPLAB Xpress cloud-based IDE is an online development environment that contains 
the most popular features of our award-winning MPLAB® X IDE. This simplified and 
distilled application is a faithful reproduction of our desktop-based program, which 
allows users to easily transition between the two environments.

MPLAB Xpress is a perfect starting point for new users of PIC® microcontrollers 
(MCUs) – no downloads, no machine configuration, and no waiting to get started on 
your system development. 

MPLAB Xpress incorporates the latest version of MPLAB Code Configurator, which 
enables users to automatically generate initialization and application C code for 8-bit 
and 16-bit PIC MCUs and dsPIC® DSCs using a graphical interface and pin map. 

With massive amounts of storage available to users, you can store your current proj-
ects in the cloud. The Community feature allows you to share your ideas with others, 
or gain inspiration from the shared code repository. 

Best of all, MPLAB Xpress IDE is free, and can be accessed from any Internet-con-
nected PC or Mac, anywhere in the world. 

1.3 MPLAB CODE CONFIGURATOR

MPLAB Code Configurator (MCC) is a free, graphical programming environment that 
generates seamless, easy-to-understand C code to be inserted into your project. Using 
an intuitive interface, it enables and configures a rich set of peripherals and functions 
specific to your application.

MPLAB Code Configurator supports 8-bit, 16-bit and 32-bit PIC microcontrollers. MCC 
is incorporated into both the downloadable MPLAB X IDE, and the cloud based MPLAB 
Xpress IDE.

1.4 MPLAB XPRESS EVALUATION BOARDS

MPLAB Xpress evaluation boards are the easiest way to get started. They feature an 
easy-to-use USB programmer, and offer full access to the features of the target MCU.



Using 8-bit MCUs in MPLAB® Xpress

DS50002710B-page 6  2019 Microchip Technology Inc.

1.5 OTHER COMPATIBLE HARDWARE

Additional hardware that may be used with MPLAB Xpress IDE are listed below.

Curiosity Development Boards

Curiosity Development Boards are cost-effective, fully integrated MCU development 
platforms targeted at first-time users, makers, and those seeking a feature-rich rapid 
prototyping board. The family offers a full on-board programmer/debugger, and several 
add-on board options.

Explorer 16/32 Development Board

The Explorer 16/32 Development Kit is a flexible, convenient and ready to start devel-
opment, demonstration and testing platform for 16-bit PIC24 MCUs, dsPIC DSCs and 
32-bit PIC32 MCUs. It features all the necessary hardware to begin developing and 
debugging a complete embedded application.

PICkit™ 3 Programmer/Debugger

PICkit 3 is a standalone programmer/debugger for use with any PIC MCU or dsPIC 
DSC DSC. PICkit 3 is the perfect option for those with their own custom prototype hard-
ware.
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Chapter 2.  Equipment Used

2.1 INTRODUCTION

This content of this document was developed using the tools listed in the following 
sections:

• Hardware

• Software

• Additional Resources

2.2 HARDWARE

• MPLAB Xpress Evaluation Boards: http://www.microchip.com/xpress

• USB cable type A to type micro-B

2.3 SOFTWARE

• MPLAB Xpress IDE: http://www.microchip.com/xpress

• Free Terminal Emulation Software:

- Tera Term (Windows only): http://www.teraterm.org

- CoolTerm (Windows, Linux, MAC OS): http://freeware.the-meiers.org/

2.4 ADDITIONAL RESOURCES

• MPLAB XC8 C Compiler Homepage: http://www.microchip.com/xc8 

• MPLAB Code Configurator Homepage: http://www.microchip.com/mcc  

• MPLAB Xpress Wiki Homepage: http://microchip.wikidot.com/xpress:start 
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NOTES:
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Chapter 3.  Programming the Evaluation Board

3.1 INTRODUCTION

The purpose of this section is to introduce basic concepts of the MPLAB Xpress IDE 
with one of the available example projects.

• Opening an Example Project in MPLAB Xpress IDE

• Download an Example Project to the Evaluation Board

• Setup Serial Communication with the Evaluation Board

• Programming Result

3.2 OPENING AN EXAMPLE PROJECT IN MPLAB XPRESS IDE

1. Navigate to the MPLAB Xpress IDE homepage and click on the Examples link 
at the bottom of the page under the “Community” heading:
https://www.microchip.com/xpress 

OR

You can navigate directly to the examples page via:
https://www.microchip.com/xpress/examples 

OR

Navigate to the examples page from within the MPLAB Xpress IDE by clicking 
on the Examples link at the top of the IDE window.
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2. On the MPLAB Xpress Examples homepage, filter through the examples as fol-
lows:

a) Author: Microchip Technology 

b) Tags: #GettingStarted

c) Board: Xpress Board

d) Device: <the device you are using>
In this example the PIC16F18877 is used.
The name of the device populating a given MPLAB Xpress Evaluation Board 
can be found next to the board's USB connector.

Scroll through the available examples and locate “Using MPLAB Xpress Exam-
ples.” A description of the example, along with any additional resources which 
could include videos links to step-by-step tutorials and more, can be accessed 
by clicking on the title of the example.

Open the example inside the online MPLAB Xpress IDE by clicking on the  
button in the Open column.
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All source code is available along with information related to the development 
tools and device that the project was configured to use.
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3.3 DOWNLOAD AN EXAMPLE PROJECT TO THE EVALUATION BOARD

1. Connect the MPLAB Xpress Evaluation board to an available USB Port on the 
computer.

2. Once connected and the device drivers have completed installation, the MPLAB 
Xpress Board should be recognized as a Mass Storage Device on the Host Com-
puter and listed as an available drive (Windows® Explorer shown here).

3. Click on the Make and Program Device   button at the top of the MPLAB 
Xpress IDE to generate and download a .hex file that will be used to program 
the PIC16F18877 microcontroller populating this particular MPLAB Xpress Eval-
uation Board.

In some browsers the generated .hex file may be available within the browser 
window or may need to be accessed from a “Downloads” folder associated with 
the browser. Navigate to the downloaded .hex file and drag it into the XPRESS 
directory shown in Step 2.

Once the Using_MPLAB_Xpress_Examples.hex file has been dragged and 
dropped into the XPRESS directory, the LED on the MPLAB Xpress Board will 
briefly flash red, indicating that the PIC16F18877 is programmed.
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3.4 SETUP SERIAL COMMUNICATION WITH THE EVALUATION BOARD

1. Open a terminal emulator program on the host computer and select the COM 
port associated with the MPLAB Xpress board.

In this example a free program called CoolTerm is used. If using CoolTerm, open 
the Connection>Options dialog and configure the serial port at the 9600 baud 
rate.

Click OK to continue.

2. Inside the terminal window, click on the  button to establish connection 
with the MPLAB Xpress board.

Note: The COM port number will vary from that shown below.
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3.5 PROGRAMMING RESULT

Once communication is established, the terminal window should display the message 
“Hello from your Xpress board!”
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Chapter 4.  Launching MPLAB® Xpress MCC Plugin

4.1 INTRODUCTION

This chapter demonstrates how to launch the MPLAB Code Configurator (MCC) plugin 
from within MPLAB Xpress IDE. MCC is a free graphical programming environment 
that generates seamless, easy-to-understand C code that is inserted into your project. 
Using an intuitive interface, MCC enables and configures a rich set of peripherals and 
functions. 

The example project from the previous chapter will be used.

• Opening the MCC Plugin for the First Time

• MCC in MPLAB Xpress

4.2 OPENING THE MCC PLUGIN FOR THE FIRST TIME

1. Launch the Manage MPLAB Xpress Code Configurator dialog by clicking on 

the  button at the top of the IDE or 
through Tools>Embedded>MPLAB Xpress Code Configurator.
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The Manage MPLAB Xpress Code Configurator dialog should now be open.

2. STEP 1 ensures that the latest Java Runtime Environment (JRE) is installed on 
your computer. If unsure of the current version of the JRE on your computer, click 
on the 'Which version do I have installed?' link and follow the steps.

Clicking on the green Download & Install JRE button will redirect you to the 
Java Runtime Environment homepage. To install JRE, simply follow the instruc-
tions. 



Launching MPLAB® Xpress MCC Plugin

 2019 Microchip Technology Inc. DS50002710B-page 17

3. STEP 2 is used to download the necessary .jnlp file to launch MCC.

MCC is a Java application that runs directly from the internet using a web 
browser (Chrome is used here). This requires the use of the Java Web Start 
application software which follows the Java Network Launching Protocol (JNLP) 
to download and launch the application.

a) Click the green Download MCC button to download the JNLP file. Then click 
on the MCC_Xpress.jnlp file to launch the Code Configurator.

b) Click Run when prompted to run the application.

c) The Enter Token from MPLAB Xpress window will now open.
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4. STEP 3 provides a unique token value that will be used in the Enter Token from 
MPLAB Xpress window. To locate the token, return to the Manage MPLAB 
Xpress Code Configurator window. Then click on the Copy button next to the 
unique token value..

5. Return to the Enter Token from MPLAB Xpress window. Past the copied token 
value into the “Please enter your Token” field.

6. Click OK to initialize the device-specific libraries for the microcontroller selected 
and open the MCC. 

If the token is not valid, refresh the token value in STEP 3 by clicking on the 

Refresh Token Value button  in the Manage MPLAB Xpress Code 

Configurator window. 

7. Recopy the new Unique Token Value and paste into the “Please enter your 
Token” field of the Enter Token from MPLAB Xpress window.
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4.3 MCC IN MPLAB XPRESS

The MCC is a graphical programming environment used to configure device features 
including oscillator setup, peripheral configuration and assign signals within the micro-
controller to pins on the device package. You are encouraged to take some time and 
explore the configurator to see how the MCU was configured to implement the “Using 
MPLAB Xpress Examples” example project.

Source and header files generated for the original project can be viewed in the Project 
pane of the MPLAB Xpress IDE under the Header Files and Source Files folders.
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NOTES:
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Chapter 5.  Using the MPLAB® Code Configurator (MCC)

5.1 INTRODUCTION

The MPLAB Code Configurator (MCC) is a Graphical User Interface (GUI) that gives 
the developer a high level view of a given microcontroller, making it much easier to con-
figure:

• Core device capabilities 

• Peripherals and configuration

• MCU signal pin assignment

• Related libraries

These features can all be configured through the use of intuitive drop-down menus, 
check boxes, and fields. In this way the developer can quickly configure the target 
device, minimizing the amount of time spent reviewing registers in a data sheet.

Key MCC tool areas are shown in the screen capture below.

Key tool areas are discussed further in these topics:

• Project Resources

• Device Resources

• Composer Area

• Pin Manager



Using 8-bit MCUs in MPLAB® Xpress

DS50002710B-page 22  2019 Microchip Technology Inc.

5.2 PROJECT RESOURCES

Displays device features currently being used in this project.

5.2.1 System Module

Configure core parameters such as the system clock, configuration bits and other 
device-level functions.

5.2.2 Interrupt Module

 Enable or configure interrupt priority for interrupt sources available in the project.

5.2.3 Pin Module

Configuration of individual pins selected from the Pin Manager such as pin direction 
(input or output), analog functionality and weak pull-up resistors, if available. In some 
instances a custom name can be given for a pin that will be referenced throughout gen-
erated code.
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5.3 DEVICE RESOURCES

This area displays features that are available for use for the selected target device. 
Features are added by double clicking on the listing in the Device Resources section.

5.3.1 Product Page

Links to the selected device's product homepage where the data sheet and other doc-
umentation, such as relevant application notes, can be found.
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5.3.2 Peripherals

Displays all peripherals that are available on the selected target device. Different 
devices will have different peripherals. Peripherals are added to the project by double 
clicking on the listing.

5.3.3 Libraries

Lists available libraries that have been created to simplify certain functionality such as 
using serial communication protocols. These libraries are presented to the user as any 
other module in the MCC using an easy-to-use graphical interface to configure various 
library parameters. Libraries are added to the project by double clicking on the listing.
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5.3.4 MIKRO-E Clicks

MikroElektronika Click boards™ are expansion daughter cards featuring various types 
of sensors, communication modules and other interface components that can be used 
with the target device to quickly add additional functionality to an application. Click 
boards are added to the project by double clicking on the listing in the Device 
Resources, which adds required peripherals as needed that interface with the selected 
module.
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5.4 COMPOSER AREA

Main interface area in which a peripheral, library or driver is configured.

5.4.1 Easy Setup Tab

This tab presents the peripheral, library or driver at a high level so that it can be config-
ured using intuitive check boxes, value fields and drop-down selections (EUSART 
peripheral Easy Setup shown).

5.4.2 Registers Tab

Presents the registers associated with device peripherals and features. Registers can 
be configured using either drop-down menus or by entering a hexadecimal value next 
to the register name representing individual bit settings (EUSART peripheral Registers 
shown).
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5.4.3 Notifications Tab

This tab displays important information concerning various modules that have been 
configured including warnings, hints and general information (EUSART Notifications 
shown where the System Clock was set to a lower frequency that is insufficient to 
obtain the desired Baud rate).
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5.5 PIN MANAGER

Many signals internal to the device can be routed to a user-selectable variety of pins. 
Signals can even be routed to multiple pins at the same time and pins can be shared 
by multiple modules. The Pin Manager simplifies this process using Table and Package 
views.

5.5.1 Pin Manager Table View 

Lists the pin by package pin number across the top of the table, by Port just below the 
pin number and by Module, signal Function and Direction along the left side of the 
table.

• Blue colored pins  indicate pins that can be used by a module signal.

• Green colored pins (with a lock)  indicate that the pins have been allocated to 
a module signal. 

• Green colored pins (with a chain link)  indicate that the pins are shared 
between multiple modules.

• Yellow/Orange colored pins  indicate possible alternate pins for an already 
allocated pin function. 

• The Package drop down menu can be used to change the Package View to any 
available package for the target device.
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5.5.2 Pin Manager Package View

Displays pins on the selected device package. Color codes follow above adding Gray 
colored pins indicating that the pin is not usable in the selected configuration. Micro-
controller signals can also by assigned to pins in this view by right clicking on the pin 
and selecting the available signal.
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5.5.3 Versions

This section of the MCC provides information about the versions of the component 
groups that make up MCC. These component groups are called libraries. Intermediate 
users can configure the MCC to use a specific version of a library for a given MCC proj-
ect. More information is available in the MCC User's Guide available in the MCC home-
page in the documents section at the bottom of the page: 
http://www.microchip.com/mcc
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Chapter 6.  Building a Serial Communications Link

6.1 INTRODUCTION

The purpose of this chapter is to demonstrate how to build the serial communications 
link that has been used throughout this document between an MPLAB Xpress Evalua-
tion Board and a host computer. This communication is enabled by a second MCU with 
USB capabilities that populates the board along with the target MCU. This second MCU 
with USB performs the following USB tasks:

• USB Mass Storage Device (MSD) Class: Receives .hex files from the host PC 
and then programs the target device using Microchip's In-Circuit Serial Program-
ming™ (ICSP™) technology.

• USB Communications Device Class (USB CDC): Translates EUSART data trans-
missions from the target MCU and transmits over the USB connection to the host 
PC

Using the latter CDC configuration enables the target MCU to send and receive infor-
mation through the second MCU with USB capabilities to an available USB port on a 
host computer. Terminal emulation software (see links in Chapter 2. “Equipment Used”) 
running on the host computer connected to the associated COM Port can then be used 
to display information from the target MCU or allow the user to send commands back 
to the microcontroller.

Note: Hardware debugging is not available.
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6.2 HOW TO CREATE A NEW PROJECT IN MPLAB XPRESS IDE

At this point only existing projects have been covered. In this section, you will create a 
new original project in MPLAB Xpress IDE.

1. Navigate to MPLAB Xpress IDE.
https://mplabxpress.microchip.com/mplabcloud/ide 

2. Create a new project by clicking the New Project icon   or by selecting 
File>New Project.

3. In the New Project window, select “Microchip Embedded” in the “Categories” 
frame and “Standalone Project” in the “Projects” frame. Click Next.
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4. Select or type in the MCU being used (PIC16F18877 shown) in the “Device” 
drop-down in the Select Device window. Click Next.

5. Name the project something relevant, like HelloSerially, in the “Project Name” 
field of the Select Project Name window. Click Finish.
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The MPLAB Xpress IDE workspace should look similar to below.

6.3 HOW TO SET UP MCC TO GENERATE PROJECT CODE

Once your MPLAB Xpress project is created, you will set up MPLAB Code Configurator 
(MCC) options for generating code.

1. Open the MCC plugin by clicking on the  button at the top of the IDE or 
through Tools>Embedded>MPLAB Xpress Code Configurator. For details on the 
MCC GUI, see Chapter 5. “Using the MPLAB® Code Configurator (MCC)”.

2. In the open MCC window, the default parameters for the “Project 
Resources>System” can be used.

3. In the “Device Resources” area, scroll down to locate the EUSART peripheral 
and expand. Double click on the EUSART to add the peripheral to “Project 
Resources.”



Building a Serial Communications Link

 2019 Microchip Technology Inc. DS50002710B-page 35

4. Select the EUSART peripheral under the “Peripheral” heading in the “Project 
Resources” pane to open the peripheral configuration and configure as follows:

a) Enable Transmit

b) Baud Rate: 9600 (default)

5. In the “Pin Manager” section, connect the EUSART TX signal to pin RB6 and the 
RX signal to pin RB7 by clicking on the blue unlock button, turning it to a green 
locked symbol, for the associated signal row and pin columns as shown below.

When communicating with the second microcontroller using USB, the RB6 pin is  
for the EUSART transmit (TX) signal and the RB7 pin is for the EUSART receive 
(RX) signal on most MPLAB Xpress Evaluation Boards, including the green 
“General Purpose MPLAB Xpress Evaluation Board” and 40-pin variants of the 
red “Device-Specific MPLAB Xpress Evaluation Boards.” The 20-pin red 
“Device-Specific MPLAB Xpress Evaluation Board” will use the RA1 pin for 
EUSART TX and the RA0 pin for the EUSART RX signal.
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6. Click the Generate button in MCC to create the appropriate header and source 
files for this configuration.

7. The new MCC Generated header and source files should now be present in the 
Project window of the MPLAB Xpress IDE including a new main.c source file.



Building a Serial Communications Link

 2019 Microchip Technology Inc. DS50002710B-page 37

6.4 HOW TO USE THE MCC-GENERATED SERIAL FUNCTION

The MPLAB Code Configurator generates code used to configure the device and 
selected peripherals. Additionally, a series of functions are generated for a number of 
the selected resources that enable you to write your own code which can facilitate 
dynamic system changes to occur at runtime. Function descriptions along with exam-
ple code can be referenced in the associated peripheral's header file.

1. Highlight the eusart.h file under the “Header Files>MCC Generated Files” 
folder inside the Project pane of the MPLAB Xpress IDE to open the file.

2. Scroll through the eusart.h file to locate the EUSART_Write() function.

Highlight the function and copy using Ctrl+X (Windows keyboard shortcut).

Note: Copy and paste within the MPLAB Xpress IDE must be done using key-
board shortcuts. Using these functions from the toolbar or from the right 
click Context Menu is not supported.
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3. Click on the main.c source file in the Project pane to open the file and scroll 
through the code to locate the // Add your application code comment 
inside of the while(1) loop inside main().

Paste the copied EUSART_Write() function at this location and replace the 
arguments within the brackets to a character such as 'A'.

4. Compile and download the project .hex file by clicking on the Make and 
Program Device button at the top of the MPLAB Xpress IDE.

5. Program the MPLAB Xpress board by dragging the project .hex file from the 
downloads section of the browser and dropping the file into the XPRESS drive 
as shown in Chapter 3. “Programming the Evaluation Board”.
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6.5 HOW TO DISPLAY THE SERIAL MESSAGE ON A HOST COMPUTER

1. Open a terminal emulator program (see Section 2.3 “Software”) on the host com-
puter and select the COM port associated with the MPLAB Xpress board.

2. Open the Connection>Options dialog and configure the serial port at the 9600 
baud rate that was configured earlier in the project when configuring the 
EUSART in MCC.

3. Inside the terminal window, click on the  button to establish connection with 
the Xpress board.

Once communication is established, the terminal window should display the character 
added to the EUSART_Write() earlier in the project.
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NOTES:
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GETTING STARTED USING
8-BIT MCUs IN THE MPLAB®

Xpress ECOSYSTEM

Appendix A. MPLAB® Xpress Evaluation Boards

A.1 INTRODUCTION

MPLAB Xpress Evaluation Boards have been designed to work in conjunction with the 
cloud-based MPLAB Xpress Integrated Development Environment (IDE). The combi-
nation of the IDE and the MPLAB Xpress Evaluation Board provide a platform for rapid 
development of applications without having to download or update the IDE or compil-
ers.

All MPLAB Xpress boards contain two sections:

1. The programmer section, which contains the circuitry necessary to serve as a 
dedicated drag-and-drop programmer for the target device using Microchip Tech-
nology's proprietary In-Circuit Serial Programming (ICSP) protocol. In this way, 
no additional hardware is needed to program the target device other than a sim-
ple USB connection to a host computer.

2. The application section, which contains the circuitry that is used by the micro-
controller application.

Additionally, MPLAB Xpress Evaluation Boards feature a Communications Device 
Class (CDC) interface to facilitate serial communication between the target device and 
a host computer. 

There are three variants of MPLAB Xpress Evaluation Boards:

1. General Purpose MPLAB Xpress Evaluation Board

2. Device Specific MPLAB Xpress Evaluation Board (20-pin variant)

3. Device Specific MPLAB Xpress Evaluation Board (40-pin variant)

A.2 POWERING THE BOARDS

The MPLAB Xpress Evaluation Boards can be powered in one of two ways, depending 
on its usage. It should be noted that only one power source should be connected at a 
time.

A.2.1 USB Connector 

The USB connector will power the entire MPLAB Xpress Evaluation Board. With USB 
power connected, the power LED will always be on (green) to indicate that +3.3V is 
available on the board.

A.2.2 2.7V-16V External Power Supply (General Purpose MPLAB 
Xpress Board Only)

The external power supply option is available on the General Purpose MPLAB Xpress 
Board only. It will also power the entire MPLAB Xpress Evaluation Board. The external 
power supply is connected to a Low Dropout (LDO) voltage regulator, configured to 
deliver 3.3V to the board. The external power supply range is from 2.7V to 16V, allow-
ing use with two to six primary cells, 9V alkaline batteries, or one or two-cell Li-Ion bat-
teries. LED D1 will illuminate green when the external power supply is active and 
supplying sufficient voltage.
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A.3 GENERAL PURPOSE EVALUATION BOARD

The MPLAB Xpress General Purpose Evaluation Board features an 8-bit PIC16F18855 
microcontroller. This board differs from other variants in that it also features basic inter-
face components to the target device such as LEDs, potentiometer, switch and more.

1. PIC16F18855 target microcontroller

2. Connection header corresponding to target microcontroller pins 

3. mikroBUS™ socket to accommodate a variety of plug-in MikroElektronika Click 
boards™ that can be used in application development

4. Four user LEDs

5. Potentiometer

6. EMC1001 temperature sensor

7. Push button switch 

8. Master RESET switch

9. LED:

a) Green: power to target

b) Flashing Red: target being programmed

10. 2.7V-16V Battery/External power connection
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A.4 DEVICE-SPECIFIC EVALUATION BOARDS

The MPLAB Xpress Device Specific Evaluation Boards contain a specific PIC16 or 
PIC18 device the board is targeted towards in addition to the built-in programmer. They 
are available in 20-pin and 40-pin variants based on the device.

1. Target microcontroller

2. Connection header corresponding to target microcontroller pins 

3. Master RESET switch

4. LED:

a) Green: power to target

b) Flashing Red: target being programmed

5. Selects 5V from USB supply or 3.3V from LDO regulator output to power target 
device (default is 3.3V)
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NOTES:
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GETTING STARTED USING
8-BIT MCUs IN THE MPLAB®

Xpress ECOSYSTEM

Appendix B. MPLAB® Xpress Evaluation Board Schematics

FIGURE B-1: GENERAL PURPOSE EVALUATION BOARD SCHEMATIC (APPLICATION 
SECTION) 
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FIGURE B-2: GENERAL PURPOSE EVALUATION BOARD SCHEMATIC (PROGRAMMER 
SECTION)
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FIGURE B-3: 20-PIN DEVICE-SPECIFIC EVALUATION BOARD SCHEMATIC
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FIGURE B-4: 28-PIN DEVICE-SPECIFIC EVALUATION BOARD SCHEMATIC
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FIGURE B-5: 40-PIN DEVICE-SPECIFIC EVALUATION BOARD SCHEMATIC
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